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Chapter 1 – Getting started 

  Introduction  

This tutorial describes how you can model, calculate and check a structure with composite floors in SCIA 
Engineer. 

For the composite beam design the module “sensd.03 : Composite Beam Design” is needed. It is included in 
the Professional, Expert and Ultimate Edition. 

 

Below you can find an image of the workspace of SCIA Engineer and where to find the different components. 
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  Chapter 1: Modelling  

In this chapter we will illustrate how to model a structure with composite floors in SCIA Engineer. 

 

Project data 

Create a new project. In the project data dialog (Main menu > File > Project settings) you need to activate 

both Concrete and Steel materials and you need to select Eurocode (EC – EN) as code since the composite 

beam check is only supported for EN1994: 

 
 

Cross-sections 

Via Main menu > Libraries > Cross-sections you can add some preliminary cross-sections that we need for 
this project. Select the Profile Library, click on the item UC and add the cross-section UC254/254/73 with 
clicking on 'Add' or on the arrow-button. A dialog with the cross-section characteristics is opened, which you 
can confirm with 'OK'. Now you can add following cross-sections from the Profile Library. 
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Modelling the geometry 

Steel frame 

Select Rectangular grid via Input panel > workstation Structure > category Grid & Stories. 

 

Set the geometry of the grid and confirm with 'OK'. A new window appears and you can confirm with 'OK'. 
Define as coordinates 0 0 0 or 0;0;0 and confirm with enter. End the command with escape. 

 

A good way to start is by using a 3D block (Input panel > workstation Structure > category Import & blocks > 
Catalog blocks): 
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We will select a 3D structure with beams and columns via the item Frame from the group Frame 3D: 

 

We also need to define the span lengths and the floor height as the geometry of the catalog block. Later, we 
can easily adapt this standard geometry to include any kind of irregularities. 

 

We finish with OK, and the software will ask us where to insert the block. Activate the SCIA Spotlight by 
clicking in it or using the space bar. Define as coordinates 0 0 0 or 0;0;0 (to add the block to the origin of the 
Global Coordinate System or GCS) and confirm with enter. End the command with escape. 

Now we can define supports. Select support in node via Input panel > workstation Structure > category 
Boundary conditions. 
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Or via ALT and right-mouse click you can use the Marking menu (available in the new interface since 
SCIA21.1) to quickly launch the Support In Node command in the Model tab: 

 

Select a hinged constraint and then choose Rigid for Ry and confirm with 'OK'. 

 

You can use the View bar to show/hide volumes, shading, supports, loads, model data, labels, ... 

 

Via More options you can choose for More view settings in order to access all view parameters. You can 
access this dialog as well via right-clicking in the graphical window. 
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You can set the View Parameters to identify the modelled geometry better. You can use the option: Colour 
by cross-section. 

The modelled structure now looks like this: 

 

We will move one of the columns to create a more irregular geometry. This will help us better understand 
how the composite functionality behaves in such cases and will allow us to make use of the benefits SCIA 
Engineer provides in the optimisation of composite floors. 
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You can add an irregularity to the geometry by moving one of the columns. You can for example select a set 
of nodes with a selection by window and change their coordinates. Afterwards the grid can be adapted as 
well. 

 

Bracings can be added to the walls and the roof of the building: 

 

You can set the axial force only behavior as the FEM type of the members: 
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Composite deck 

There are two possibilities for modelling the slabs: we can add a composite deck, or a ribbed slab with 
composite properties. For the analysis and design, the two options give the exact same results. 

• Option 1: Use Composite deck in the cases where you would like to remain more flexible in the 
modelling: this option allows you to draw the deck separately and add any beam layout to that deck. 
This option is good for irregular geometries and when you would like to model the whole composite 
floor as one slab. 

• Option 2: Use Ribbed slab for regular geometries, and when you would like to switch between 
different number of ribs per bay easily: this option lets you draw the deck and ribs together; you may 
also change the number of ribs per deck easily, but using this option requires you to model a 
separate deck for each bay. 

 

During the modelling of the deck (regardless of how you define the slab), SCIA Engineer will ask you to 
choose a steel decking profile from the library (e.g. ComFlor 60-1.2). You can input your own sheeting 
geometry if the sheet you are looking for is not in the library. 
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After selecting the Composite deck item in the Input panel, we use the default settings of this type of 2D 
member. We only adapt the thickness of the slab to what we need (e.g. 155 mm) or use the default. 

We define the 2D member geometry by picking points on the perimeter of a floor. 

In order for a 2D member to be considered by the software as a composite deck, the following property is set 
as Element type = Composite deck. Switching this property to another value will deactivate the Composite 
analysis model. 

2D members of type Composite deck can also be set to Element behaviour = Rigid diaphragm, so that the 
plate is a rigid body for the horizontal loads and tributary areas are used to distribute the vertical loads. 

 

After adding a composite deck in the model, SCIA Engineer indicates that it will create partial self-weight 
load cases. This is needed in order to manage the different density of concrete during construction stage. 
This happens automatically, no further action is requirement from you as user. 

 
You can disable the provisions for fresh concrete in the Composite Settings. 

We can use the Copy (or Multicopy) function to create 3 additional slabs. You can use the Marking menu 
again to quickly launch the Copy or Multicopy command in the Modify tab. We obtain a structure as follows: 

  



Tutorial – Composite Floors 

14 BV – 2022/01/26 

 

 

We can define the concrete slab and the composite beams at once by using the option Ribbed Slab. 

The advantage of using a ribbed slab is that the number of ribs and their location can be adapted at any 
point in time after the slab has been modelled, also during the design process. 

The disadvantage of the ribbed slab option is that the slab needs to be split where the spans of secondary 
beams end. 
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On the roof, we will set the Element type of the 2D member to Metal deck instead of Composite deck. This 
will remove the layer of concrete on that level. The Element behaviour will be set to Flexible diaphragm 
automatically. This behaviour means very low horizontal shear stiffness and ensures that horizontal loads 
from the diaphragm are distributed to load bearing elements similarly to a load panel. 

 

When using Composite deck for the modelling of composite slabs, the internal composite beams (ribs) have 
to be added separately. These can be added as general 1D members and later connected to the deck, or 
can be drawn as ribs directly. 
By using main menu > View > Visibility (e.g. Hide selected), we can select a floor to work with; later we will 
copy all new members to the other floors. 

We can set the snapping option depending on how many ribs we would like to model per bay. In this case, 
we will add two internal secondary beams per bay, so we set for Line divisions Repeat = 3. 
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We will model the composite beams as general 1D members. The advantage here is that we can copy them 
easily to the other slabs (other floors). Ribs can only be copied from and to the same 2D member. 

 

Then we copy the following 1D members to the other floors. 

 

We see that the orientation of the sheeting ribs (throughs) on the 2D member is not as we intended: namely 
to orient the ribs along the global X-axis. 

 

The sheeting orientation is determined by the Local Coordinate System (LCS) of the composite deck and 
is indicated on the slab together with the loading direction and slab name (if set to be displayed). The purple 
line at midspan of the beams above indicates the tributary areas that have been generated. We see in this 
case that loads go directly to our primary beams, which is incorrect. 
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If we adapt the property LCS angle = 90, this will rotate the sheet and update the derived tributary areas per 
beam. All loads applied to the slab now will be distributed to the underlying secondary beams based on their 
tributary areas. 

 

We should not forget to change the property LCS angle for all slabs in this model. 

SCIA Engineer automatically determines tributary areas per beam, taking into account the beam layout in the 
slab. For composite decks, a one-way distribution of loads is assumed, parallel to the sheeting ribs. 

Tributary areas can be customised in the following ways: 

• Beams can be excluded from the distribution of loads. 

• A tolerance can be set for the angle of transfer: this affects beams that are not exactly perpendicular 
to the sheeting ribs. 

For our slightly irregular structure, we need to switch the property Max. angle for transfer in the 2D member 
properties from the default value to 11 degrees to obtain a better layout of tributary areas per beam. 
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We will use the command Connect members/nodes to link the beams to the 2D members as ribs (this step 
is not necessary when the composite beams have been drawn as slab ribs directly). 

 

Use selections to prevent the connection of the braces as rib. 

 

Some additional properties appeared in the 1D member property sheet after the beams were linked to a 
composite slab. 
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The type of connection property has the following values: 

• With standard composite action: with this option the correct stiffness is taken into account in the 
analysis, and also no axial internal forces appear in the composite beams, and is thus recommended 
for Eurocode 4-based checks 

• With advanced composite action: large axial forces will appear in the beams due to the modelled 
eccentricity between beams and slab, and bending moments will be lower, and is thus unsafe for 
Eurocode 4 checks 

• Without composite action: allows for quick switching between composite and non-composite 
design (using the steel section alone without connection to the deck) 

• User-defined eccentricity: this option is not intended for composite beams: it is useful in the 
modelling of e.g. ribbed concrete plates. 
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Boundary conditions 

It is a good moment to add the necessary hinges to the composite beams. Later, these hinges will be taken 
into account in the automatic detection of system lengths for 1D members. 

 
 

System lengths are important in two ways: 
1) these are used in the determination of effective widths of composite beams on analysis level, 
2) for the determination of lateral torsional buckling lengths in the case of negative bending in the 

composite beams. 

Select all primary and secondary beams and assign them hinges at both ends with fiy and fiz rotation 
set as free: 
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System lengths and buckling 

For the secondary beams the system length will be correct since the elements consist of only 1 span. 

Verifying the system length settings for the primary beams is more important. Although SCIA Engineer 
recognises all framing members, it does not always recognise the direction of provided support correctly, 
especially when 2D members are also rigidly connected to beams/ribs. 

We need to manage two buckling groups for the primary beams: 

• A group with 4 spans for the beams connected to the K-bracing; 

• A group with 3 spans for all other beams. 

The best way to proceed is to use the Expand selection method and use the property Materials and no of 
parts. To avoid selecting the columns, select them first and exclude them via View > Visibility > Hide 
selected. Select one of the beams connected to the K-bracing and select all beams with identical number of 
parts. 

 
 

We see that, by default, the software assumes that the bracing fully supports the beam at mid-length. This 
depends on the choice of cross-section for these elements, but in most cases, the brace will not be able to 
work in compression to carry gravity loads. So we will disable this support by clicking on it. In the z-z 
direction, we disable the middle support. 
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SCIA Engineer assumes a support there because the rib is rigidly connected to the slab. The z-z direction is, 
in a majority of cases, not relevant for composite floor design. In specific cases we may want to rely on these 
settings for the construction stage checks: when studs are not directly welded to the beam through the steel 
sheeting, but holes are provided in the sheeting instead. The z-z direction is by default used for LTB (lateral 
torsional buckling). You can modify that, or you can also work with LTB restraints instead. 

We select the rest of the primary beams by the criteria number of parts =3. The recognition was not perfect 
in this case: the secondary beams are assumed to provide vertical restraint as well. We disable these 
supports by clicking on them. 

 

For the columns, the buckling settings and design approach generally do not differ due the presence of 
composite beams, when comparing to other building examples: 

• we have assumed what the boundary conditions are at intersections with other building elements, 

• we identify columns that share the same settings and assign them to buckling groups accordingly. 

Sway settings are important for columns. To know if the structure is sufficiently stiff in the horizontal 
directions, i.e., whether sway failure can happen and whether second-order analysis must be used for the 
design, stability analysis may be performed. 

We can initially set all spans of the columns to non-sway and run the steel code check Autodesign to get an 
idea of the minimal cross-section of the columns and the building sensitivity to lateral movement. See also 
part Steel code check in Chapter 3 of this document. 

From the stability analysis (see also chapter 5) and obtained modeshapes with critical load coefficient lower 
than 10, we can tell if sway failure should be considered. If yes, the sections would most likely need to be 
increased eventually. This part of the design is an iterative process as the stability analysis results will also 
change with the larger cross-sections. Therefore, it is good to build some tolerance in the cross-section size. 

Further information on steel design is available in the SCIA steel manual. 
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Composite beam visualisation 

Due to the assumptions used in FEM analysis when the option ‘With standard composite action’ is activated 
in the 1D member properties, the beams and slab are displayed on one level in the analysis model. This is 
closer to the computational reality than showing the beams underneath the slab. 

 

A good way to visualise the actual building system is via the structural model: there, the alignment can be 
set without it influencing the analysis results. The alignment of 1D and 2D members is done via the property 
panel, inside the group ‘Structural model’: 

 

We can set the alignment of the 1D members to Top and the alignment of the 2D members to Bottom. 

We can generate the structural model via View > Visualization > Generate structural model. 
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  Chapter 2: Loads  
 

 

Automatic stages 

Whenever composite decks are present in the model, three stages of construction and exploitation are 
considered: 

• Construction stage; 

• Final stage, long-term (creep in concrete is considered); 

• Final stage, short-term. 

Construction stages are managed in the background automatically both on the level of analysis and on the 
level of checks and design; yet, it is important to understand how stages work and how one should set up the 
model correctly. 

A setting in the Load cases dialog determines which loads are applied in which stage. 

 
 

Construction stage 

If a load case is put in Construction stage, this load case will be calculated assuming that the concrete in 
the composite decks hasn't hardened yet: in the FEM analysis, only the steel beams and sheeting will 
contribute with their stiffness to resisting the loads. 

Self-weight and variable loads during the construction stage should be placed in Construction stage. 

 

Final stage, long term 

If a load case is put in Final stage, long-term, the concrete in the composite decks will be taken into 
account in the calculation of this load case, but the E-modulus (set in the Material library) will be reduced, to 
take into account creep. The creep coefficient (which determines how much the E-modulus will be reduced) 
can be changed in the Composite settings (main menu > Design > Composite > Settings). 

All loads that will be applied on the structure for long enough to induce creep effects should be put in Final 
stage, long term. Typically, permanent loads during the exploitation phase are put in this stage. 
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Final stage, short term 

If a load case is put in Final stage, short term, the concrete in the composite decks will be considered with its 
full stiffness for the calculation of this load case. Typically, all variable load cases from the exploitation phase 
(live load, wind, snow) should be put into this stage. You can select to put part of the live load (the quasi- 
permanent part) in Final Stage, long term, but this is normally not required. 
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Load cases 

In this chapter we will discuss the load cases and load groups. In total we will create 10 load cases and 5 
load groups. 

 
 

The software will automatically place these load cases in the appropriate stage. You can verify in what stage 
each load case is placed and correct it in the composite menu. 
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Self-weight 

Self-weight is created and managed entirely by SCIA Engineer. To manage the weight of fresh concrete 
during the construction phase in a clear way, three partial load cases are generated to represent self-weight: 

• Self-weight: the self-weight of all modelled elements, including the steel sheeting in the composite 
decks, 

• Fresh concrete self-weight: the self-weight of the concrete in the composite decks with higher 
density to account for the additional water before the concrete has hardened. 

• Dry concrete self-weight: the self-weight of the concrete in the composite deck with normal density. 
This is a permanent load case and is used in the final stage checks. 

All three load cases of self-weight should be considered in Construction stage in staged analysis. This is 
because deformations resulting from these loads have settled in the structure before the concrete has fully 
hardened. 

Both the dry and fresh density of concrete are set in the Material library. 

 

If you don't want to consider the increased concrete weight during construction, you can disable this 
functionality via the Composite settings. The partial load cases will be replaced by a single load case of self- 
weight for the whole structure. For this tutorial, we will not disable this, and we will consider the fresh 
concrete weight separately. 

 

The three parts of the self-weight can be displayed on the structure after the project has been calculated. 
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LC1 – self-weight: 

 

LC1 – fresh concrete: 

 

LC1 – dry concrete: 
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Construction loads 

You can create a variable load case in Construction stage to represent the loads during execution. The load 
group “Construction” has already been generated by the software, as it contains the fresh concrete weight; 
therefore, we can directly assign to it. 

 

Via the Input panel > workstation Loads, we apply the load: 

 

It can be applied as distributed load on the composite decks, or as line or point loads on the composite ribs, 
depending on engineering judgement. In this example, we apply a 1 kN/m2 distributed load on the composite 
2D members. 

For demonstration purposes, we apply the construction loads on the roof as line (1.5 kN/m) and point loads 
(2 kN) on the beams. To easily verify what we have modelled, we use the View settings for all entities > 
setting “Colour by load type.” This allows us to show point, line and surface loads in different colours. 
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Permanent loads 

We create a permanent load case LC3 – Permanent in Final stage, long term. It is automatically assigned to 
load group LG1, which contains already the self-weight of the rest of the structure and the self-weight of the 
dry concrete. 

We apply 1,5 kN/m2 distributed load on the floors and 0,8 kN/m2 distributed load on the roof. 
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Live loads 

In the case where there are continuous beams in the structure, it is prudent to consider two load scenarios 
when it comes to live load: 

• first, the full slabs are loaded with the maximal value of live load; 

• second, a pattern loading case: every second bay is loaded with the full live load, while the rest of the 

bays remain unloaded. 

The second load scenario will lead to higher values for e.g., bending moments in the columns. 

We create two variable load cases in Final stage, short term: 

• LC4 - Live load, 

• LC5 - Live load pattern. 

We will assign these load cases to a new Load group “Live loads” for the floors. By using the Relation 
setting “Exclusive,” we make sure that these two load cases will not be considered together in combinations. 
In the load group settings, we can also set the Category of live load, e.g., “Cat B: Offices”. 

For the first load case, we apply the load directly on the 2D members: 3 kN/m2 on each floor. 
 

In the second load case, we would like a checkerboard distribution of live loads. We can achieve this in two 
ways in SCIA Engineer: 

• By using free loads; 

• By using subregions on the composite slabs. 

In this example, we will use free loads. We define free loads with intensity 3 kN/m2 at the Z = 0 m level., By 
using the Select item in the properties of the free load, we can determine on which 2D elements this load 
should be applied. Although the free load is defined once, it acts on multiple members along its path with the 
defined intensity of 3 kN/m2. 

We can also set the Validity property of these loads from 0 to 11 m, then all three floors without the roof will 
be loaded. 
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You can visualize the generated loads by selecting a load and using the Action button ‘Generate loads’ in the 
properties panel. The loads will also be generated automatically when calculating the model or generate the 
mesh. In the view parameters you can show both the original and generated loads. 
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Roof live loads 

We will again consider two loading scenarios; in this way, we will capture the maximal possible internal 
forces that are caused by loads on the continuous primary beams. 

We create two variable load cases in Final stage, short term: 

• LC6 – Roof live load, 

• LC7 – Roof live load pattern. 

We will assign these load cases to a new variable Load group “Roof live loads”. By using the Relation 
setting “Exclusive,” we make sure that these two load cases will not be considered together in combinations. 
In the load group settings, we can also set the Category of live load: “Cat H: Roofs”. 

For the first load case, we apply the load directly on the 2D member at the roof, which we modelled as Metal 
deck earlier: 1,0 kN/m2. For the second load case, we can copy the free loads from LC5 (in the load cases 
dialog you can use the action button “Copy all loads to another load case” for this) and edit the properties 
Value (1,0 kN/m²) and Validity for this situation. 
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Snow 

We need a snow load case and a new snow load group (Relation = Standard, Load type = Snow). We can 
then define the Specification of the snow load case as “snow,” so that the value is calculated according to 
the general settings in Project settings (in this case according to the code). 

Add a surface load (which will have the type “Snow”) on the roof. 
 

 

Wind 

We will apply simplified wind load for the purpose of demonstration. The 3D wind generator could be used to 
generate the wind loads accurately on this structure. 

We will define two wind load cases in Final stage, short term: 

• LC9 – Wind front 

• LC10 – Wind left 

And we put them in an exclusive, variable load group “Wind.” We apply 1 kN/m2 suction load on the roof in 
both load cases, and we add line loads on the columns to also approximate 1 kN/m2 pressure/suction on the 
building envelope (in X direction we apply 9 kN/m on the internal columns, and 4,5 kN/M on the external 
ones, in Y-direction we apply 8 kN/m on the internal columns and 4 kN/m on the external ones). 
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LC9 – wind front: 

 

LC10 – wind left: 
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Combinations 

Load combinations are automatically generated and managed by SCIA Engineer, also in the case of staged 
analysis model for composite floors. 

Five load combinations are normally created for a structure with composite floors: 

• ULS-Set B-CS (auto): a ULS construction stage combination 

• SLS-Char-CS (auto): a SLS construction stage combination 

• ULS-Set B-FS (auto): a ULS final stage combination 

• SLS-Char-FS (auto): a SLS final stage combination 

• ULS-Acc-FS (auto): an accidental combination 
 

The first four combinations are used for the checks and design of composite members at ambient 
temperature. A Result class that contains these four combinations is generated and managed by SCIA 
Engineer. 

 

The last, accidental combination is used for the fire checks for composite members. 
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Chapter 3: Analysis and Results 
 

  Chapter 3: Analysis and Results  
 

Linear analysis 

As explained earlier in chapter 2, a staged analysis will be performed when composite decks are present in 
the deck. This happens automatically, therefore, no further action is required from the user other than setting 
up load cases in the correct stage, following what was explained in chapter 2. 

We can proceed and run linear analysis (via main menu > Tools > Calculation & Mesh > Calculate or via 
the button in the middle of the process wheel) for the modelled structure. 

 

The handling of results for a structure with composite floors does not differ from other types of structure that 
can be analysed and designed in SCIA Engineer. Therefore, the results service (main menu > Results or the 
Results workstation in the process toolbar) will not be explained here. Internal forces, deformations and 
displacements can be reviewed as done usually. 

 

2D member results like displacements, stresses, strains and internal forces are not available for the 
composite deck: this one behaves like a rigid diaphragm in the horizontal direction (thus no deformation) and 
as a load panel with tributary areas in the vertical direction. 

 

Tools 

The following are general SCIA Engineer tools which are useful for the design of not only composite beams, 
but other kinds of structural elements as well. These tools can be used when working with the results, and 
when using the checks and automatic design. 

 

Results table 

Results table is a tool that shows you results in tabular form. A few interesting features are available here: 

• when rows are highlighted in Results table (e.g. by clicking on the row number), elements in the 3D 
scene are selected and vice versa; 

• the visibility options can be used to limit the table content (button Visibility in table); 

• you can export the table content to both the Engineering Report (button Table to report) and as a 
spreadsheet to Excel (button Export to Excel). 

These features make Results table a very powerful design tool which we will use when designing the 
composite beams. You can find Results table under main menu > Tools > Results table or as action button 
at the bottom of the property panel when you ask for results. 
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Results lock 

FEM results are obtained for a certain state of the model and any changes (adding or deleting members, 
changing cross-sections or supports, etc.) normally invalidate these results. SCIA Engineer gives you the 
possibility to cache results, even if these may be outdated after some modifications, and use these results 
for check and design or simply display them on the structure. 

Result lock is deactivated by default and can be activated in the status bar: 

 

After activation, results are stored and you can still consult these while making changes to the FEM model. 
Results are eventually purged if changes that affect these were made and: 

• you deactivate Result lock; 

• you save the model; 

• you close SCIA Engineer. 

At all times, you are notified that Result lock is ON and results may be outdated: messages are displayed in 
the 3D scene, in the Preview and in the Engineering Report: 

 
 

Steel code check 

It is common to have both composite and non-composite beams in the same floor: when beams are too 
short, when studs on edge beams interfere with the façade, etc. Also, composite floors are normally 
supported on steel columns. To design non-composite elements, you should go to the Steel service (main 
menu > Design > Steel members or the Steel workstation in the process toolbar). 

The Steel ULS Check (according to code EN 1993) is an advanced design tool meant for various steel 
elements, with many built-in features like section and stability verifications, Autodesign, error/warning/note 
reporting, etc. 

Note that non-composite elements do not benefit from the stabilising effect of the concrete slab: in the steel 
code check, these will be checked and designed taking into account the weak-axis bending, horizontal shear 
and torsion that may occur in them, and taking into account the possibility of lateral torsional buckling under 
sagging moments and other stability effects. The steel sheeting may be used in the LTB (lateral torsional 
buckling) verification, and additional LTB restraints may be added within the steel service. 

We can use the steel code check to select more realistic sections for the non-composite elements. Note that 
the purpose of this example is not to design the steel parts, but to show some of the possibilities in features 
of the software other than the composite design. 

It could be that some elements (e.g. the internal columns) are failing. You can create new cross-section 
items, assign them and run the Autodesign. The steel code check Autodesign (Action button in the property 
panel when performing the steel code check) works per cross-section and does not support automatic 
creation (i.e. splitting) of cross-sections. 

For the bracing elements, you can use Steel member data (Input panel > workstation Steel) to indicate that 
only section checks are to be verified: to avoid dimensioning the brace for stability under axial compression 
forces. Note that a second-order analysis with Nonlinearity 1D of type ‘Tension only’ will give more accurate 
results for this structure, especially for the beams connected to the K-bracing. 
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Once the loads are introduced and the calculation is done, checks are available according to EN 1994-1-1 
and EN 1994-1-2 (fire resistance). These two standards refer to parts of EN 1993 and EN 1992. The checks 
can be found in the composite menu (main menu > Design > Composite or via the Composite workstation in 
the process toolbar). 

 

Also, the EC4 scope is complemented with additional publications, namely SCI P355 and SCI P405 for web 
openings and composite action respectively. 

Composite checks consider the principle bending moments My and vertical shear forces Vz in the beams. 
Axial forces are normally not present in the beams and the EN 1994-1-1 does not explain how these should 
be taken into account. Weak-axis and torsional moments, if any, are assumed to be taken up by the concrete 
slab which acts like a diaphragm. When using the Rigid diaphragm option for the 2D member one does not 
obtain any normal forces, weak axis bending and horizontal shear (aside from minor numerical effects). 

 

Composite settings 

The settings applied in the composite settings (main menu > Design > Composite > Settings or via the 
Composite workstation in the process toolbar) are applied to all composite beams and slabs in the model. 
Defaults are clearly indicated, so that you know what settings you have modified. Searching in the settings is 
enabled. 

The complexity of the staged analysis model is controlled by the following settings: 

• Taking creep into account splits the final stage into long-term and short-term behaviour. 

• The creep coefficient influences the stiffness with which long-term load cases are calculated in the 
solver. 

• Propping the composite beams disabled the construction stage altogether. 

• You can also switch off the separate handling of fresh concrete weight (self-weight) as a variable 
load from here. 
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The AutoDesign approach and some of the resistance checks are influenced by the following group of 
settings. 

In case the Calculation approach is set to Design, the stud layout will be determined automatically; if set to 
Check, you have to define the spacing of connectors manually (this spacing can be overwritten per beam as 
well). 

 

The default shear connectors and slab reinforcement are defined in this specific groups. It should be noted 
that when two connectors per row are defined, SCIA Engineer will try to place 1 row of stud when possible 
and switch to two only if needed. 

 

The last two groups control the deflection and natural frequency SLS checks. In the Deflection control group, 
you can define camber on the beams or let camber be optimised based on the need to tackle deflection 
issues. 
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Descriptions are provided for each of the settings, to provide more information of how each setting influences 
the behaviour or outcome of the analysis model, checks or AutoDesign. 

Changes in the composite settings invalidate the results, therefore, it is advisable to use Result lock if you 
would like to keep the results. Deleting is a precaution, as some of the settings influence the analysis model. 

All settings described above (except the ones pertaining to the whole model) can be modified per beam by 
assigning Composite beam data (CBD) to the beams. 

 

These settings are an attribute to the beam and can be later accessed via clicking on the little label on the 
beam or via the 1D member Properties in a specialised tab. 

 

Hiding or showing the labels for composite beam data is done via the View settings (right click on 3D scene 
> View settings for all entities > Composite tab > Display on opening the service). 

 

Shear connectors 

Shear connectors are defined via Libraries > Composite > Composite shear connectors. 

 

You can create personalized shear connectors or load them from SCIA Engineer's library. 
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Composite checks 

All ULS and SLS checks are called via Composite beam ULS+SLS check: 

 

In the properties panel, you choose: 

• on which members the checks are performed; 

• for which loads, load combinations or result classes; 

• how values are displayed; 

• what level of output is displayed in the Preview and for which members. 
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We run the checks by clicking on Refresh in the Actions section. 

ULS checks are performed when you run the checks for a load case, a ULS linear or nonlinear combination, 
or a Result class containing ULS combinations. 

SLS checks are performed on SLS linear or nonlinear combinations or Result classes containing SLS 
combinations. 

If all load cases are in construction stage, then the combination is considered as a construction stage 
combination. If there is a final stage load case in the combination, the combination is considered as a final 
stage combination. 

 

ULS checks in construction stage 

The ULS checks in the construction stage consist in: 

• verifying whether the steel beam alone can take the bending and vertical shear coming from the 
construction stage loads. The plastic bending resistance is calculated and compared to the applied 
bending moment, also taking into account necessary reductions in resistance when larger shear 
forces are present. 

• performing a Section classification to verify that the beam is either class 1 or 2. 

• verifying shear buckling if the slenderness of the steel beam web requires it. 

• performing LTB checks if needed, and this depends on how the connectors are attached to the steel 
beam : 

o if they are welded through the steel sheeting, the check is only carried out if the 
direction of the ribs is parallel to the steel member. 

o if they are connected directly to the beam, the check is always carried out. 
 

 

 

SLS checks in construction stage 

The deflections obtained in construction stage are compared to the limit values defined in the composite 
settings or composite beam data. 

Deflections in the construction stage are calculated on the level of FEM model, neglecting the stiffness of the 
concrete slab. If you would like to display these deflections, go to the workstation Result > 1D deformations 
(using Type of values = Relative deformations). 

Camber is also taken into account here (whether designed or inputted). 
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ULS checks in final stage 

In the composite (final) stage, the following resistances are verified against the load effects in ULS: 

• vertical shear section resistance and shear buckling resistance of the steel beam web; 

• bending moment resistance of the composite cross-section; 

• lateral-torsional buckling, if there are regions with negative bending moment along the beam; 

• longitudinal shear in the concrete, i.e. shear failure of the slab in a (or two) vertical plane(s) due to 
the forces transferred from the shear connectors to the concrete; 

• crushing of the concrete flange, i.e. crushing failure of the slab due to the forces transferred from 
the shear connectors to the concrete. 

In addition, the following are also verified: 

• that the cross-section is class 1 or 2, since the plastic bending resistance is used; 

• that the degree of connection provided by the studs is larger than the minimal requirements of 
Eurocode 4 or SCI P405 (depending on the selected option in the composite settings or CBD); 

• that a sufficient degree of longitudinal reinforcement is provided, in the case of negative bending 
moments along the beam. 

 

 

SLS checks in final stage 

Two deflection checks are performed in the final stage: for the total load applied on the slab and for live 
load only. The limits for total and live load deflection are defined in the composite settings or CBD. 

The natural frequency of the beams is calculated and compared to the frequency limit defined in the 
composite settings or CBD. To calculate the natural frequency, full composite action/shear connection is 
assumed between the steel beams and the concrete slab. 

The reinforcement in the slab is compared to the minimal reinforcement needed in order to limit cracks due 
to imposed deformations. 

 

 

Detailing provisions 

You can verify whether detailing conditions are fulfilled in both the Standard and Detailed output. Also, in 
case some detailing conditions are not fulfilled, a warning will be displayed to you in the 3D scene. 
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Three-parameter optimisation 

SCIA Engineer enables the optimisation of three parameters in order to fulfil the ULS and SLS checks: 

• the cross-section, 

• the composite action between the beam and the slab, 

• the camber on the beams. 

The optimisation is connected to the cross-sections: members that share the same cross-section will be 
optimised together. However, the possibility to split cross-sections is built into the routine. 

The optimisation is called through the button Apply design proposals to model in the Actions tab. 

 

It is necessary to use a class containing ULS and SLS combinations for both the construction and the 
final stage. The optimisation respects the Type of selection and Filter: these options control whether all 
beams or just selected beams are optimised at the same time. 

To clarify the last point: when a single beam is selected, it will be optimised for the internal forces and other 
relevant parameters that pertain to it alone. If more beams that share the same cross-section are selected, 
the optimisation will try to find a new cross-section that works for all beams at the same time. This is 
sometimes not possible if the beams have very different spans and load levels. This difficulty can be 
overcome in two ways: either by optimising groups of similar beams separately from the rest, or by modelling 
the floor with various cross-sections, also reflecting the desired outcome of the design. 

The Composite Beam AutoDesign window offers some additional options: 

• Modify unselected: this determines whether beams that are currently not being checked, but share 
cross-section with the ones that are being checked, should also be assigned the new cross-section 
that the AutoDesign suggests. 

• Join same cross-sections: when we are optimising multiple cross-section instances at the same 
time (two in the image below), this option allows for sections that will be changed to the same profile 
to be merged into a single entity in the cross-section library. 

• Apply changes to all cross-sections: this option allows us to select which sections should be 
changed. If we deactivate it, the tick-boxes Use design proposal will become active for each cross- 
section. 
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Other options that influence the AutoDesign are available in the composite settings. 

The option Design approach lets us influence the AutoDesign outcome by setting a preference for e.g., 
smaller sections with more studs along the beam, or larger sections with fewer studs, or something in 
between. It is possible to also restrict the beam depth. 

If the Calculation approach is set to Check, the AutoDesign will be disabled altogether. 
 

 

Stud layout 

Regarding stud layout, you can choose between: 

• Letting the software define it: SCIA Engineer takes into account the moment diagram and any 
large point loads along the length of the beam. The lowest number of studs from maximum to zero 
moment determine the actual composite action. In the case of large point forces, studs need to be 
added to cover the bending moment resistance at the location of the point loads. If maximal spacing 
conditions are not fulfilled, studs will be added as well. 

• Inputting the studs manually: you define the stud spacing and number of studs per row (1 or 2). 
The resulting number of studs are then used in the various checks that are affected: minimal shear 
connection, bending moment, longitudinal shear, web opening checks, etc. In this case, you need to 
control whether the obtained composite action is the same as defined in the properties of the beam. 

Note that the optimisation routine will also update the composite action in the 1D member properties, where 
needed. 

 

Options that have a significant effect on the stud layout are the following: 

• Use SCI P405 for minimal shear connection: you can choose whether the rules for the determination 

of minimal composite action according to SCI research are applied or not (see Annex A); 

• Negative flexural strength determined by the steel section alone: important for the design of 

beams undergoing hogging moments. Where the negative bending moments are relatively low, the 

length on which the negative moments act is normally short. It is, therefore, often impossible to provide 
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enough studs to cover the requirements for minimal composite action. This option lets us check these 

hogging moment regions assuming that is no composite action there. 

• Overwrite code-based … shear connector longitudinal spacing…: you can overwrite the spacing 

requirements of EC4. 

These options are available both in the composite settings and in the composite beam data. 
 

 

Additional checks on beams with web opening 

Defining web opening 

Openings in the webs of the steel beams are created via Input panel > workstation Structure > category 1D 
Members > Opening on 1D. In the dialog that opens, you can define the shape of the opening, the 
dimensions, eccentricity, the location along the beam and horizontal stiffeners, if needed. 

Three basic opening shapes are supported in the EN 1994-1-1 checks: rectangular, circular, and elongated 
(oval). These three are directly available in the menu. More complicated shapes may be created via the 
Cross-section option and these will be taken into account in the FEM analysis, but will not be taken into 
account in the composite checks. 

We pick one of the secondary composite beams and we define three openings on it: 

• a rectangle with dimensions 450x300 mm2, eccentricity -15 mm, at 2,0 meters from the start; 

• a circle with diameter 340 mm, no eccentricity, at 4,0 meters from the start; 

• two elongated openings with dimensions 500x280 mm2, at 6,0 meters from the start and 0,7 m 

distance between the start of the two openings (delta). 

The openings are immediately displayed on the beams. We make sure we switch them on for analysis and 
design (via the tick-box under the Calculation group). 

 

The option to repeat web openings in a single definition makes it possible to easily model cellular beams for 
example. 
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Checks at the reduced section 

SCIA Engineer will perform additional checks at the reduced section (at the web opening) and checks at the 
web posts. Annex B provides more information on these checks. 

 

 

Output for web openings 

After adding web openings to the member(s), we calculate the model and run the composite design checks 
once more. We see that the beam that we previously optimised is now insufficient. We can see details about 
the calculation by calling the Standard output via Preview. 

Table 2.1 of SCI P355 provides additional detailing conditions for beams with web openings. These so called 
practical geometric limits reflect feasibility concerns such (as the possibility to weld stiffeners) as well as 
requirements for effective force transfer around openings. 

 
 

 

Looking at that part of the standard output, we see that the first two openings (the rectangle with dimensions 
450x300 mm2 and the circle with a diameter 340 mm) are two large for the current cross-section of the 
beam. 

The summary of all performed checks for openings is located in the standard output under the corresponding 
stage (construction or final). 
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We see that for the openings OM3 (elongated shape) shear buckling, Vierendeel bending and vertical shear 
are a problem with the current cross-section and opening dimensions. 

Via the properties of the check, you can specify. whether you would like to see the output for the opening 
with highest overall unity check or the output for all openings along the beam: 

 

If we print the full output, we will see that the other openings (OM1 and OM2) also have failing unity checks. 

There are no specific SLS checks at web openings, but the presence of these is indirectly taken into account 
by the reduced stiffness and larger deformations in the FEM model. 

We can add horizontal reinforcement on the top and bottom of each opening in order to improve the 
utilisation. Not all checks are influenced by the reinforcement, e.g., shear buckling happens in parts of the 
web that are not strengthened by horizontal reinforcement at the opening. 
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Horizontal stiffeners are added via the properties of the 1D member opening. These stiffeners are only 
considered in the EN 1994-1-1+SCI P355 Composite checks and are neither taken into account in the FEM 
calculation nor visualised in the 3D scene. 

 

We can now compare the utilisation levels for the case of no reinforcement and with reinforcement. 
 

 

 

We can see that the Vierendeel bending check and the vertical shear check for closely-spaced openings 
have been significantly improved by the presence of reinforcement. Shear buckling remains a problem. This 
can be expected as the web thickness of UB406/140/39 is only 6 mm. 

 

Autodesign with openings 

The composite Autodesign works also in the case where web openings are present along the beam. 

We can now run the routine via the action button Apply design proposals to model. SCIA Engineer 
suggests us a new cross-section (UB457/152/60) and a reduced composite action. In this case the number 
of studs along the beam stays the same (30 studs, 1 in each sheeting trough), but the larger cross-section is 
what affects the value of composite action. 

The new cross-section has a web thickness of 8 mm. All unity checks are satisfied in this case. 
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Design labels 

Design labels are additional result variables. Their labels contain the following information: 

• the cross-section of the beam; 

• the number of studs per beam; 

• the camber. 

There are two types of results variables, Label uniform (LU) and Label segmented (LS). For the beams 
where no segmented layout exists, the uniform layout is shown in both cases. 
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Fire resistance checks 

SCIA Engineer offers checks for composite beams at elevated temperatures according to EN 1993-1-2 for 
the construction stage and according to EN 1994-1-2 for the final stage. Both checks are available from the 
Composite menu. 

 

In the construction stage, the steel beam is assumed to be exposed from all four sides. In the final 
stage, the steel beam is considered as exposed from three sides, and the temperature distribution in the 
concrete slab is calculated in the depth of the concrete slab. 

These fire resistance checks are not performed on beams with web openings: SCI P355 does not give any 
design rules for composite beams under elevated temperatures. If web openings are present on a beam, an 
error message is displayed. You can still disable the openings temporarily and run the fire resistance checks 
assuming that the beam has a solid web. Result lock can be used in this case. 

There are additional options that apply only to the fire resistance checks, in addition to the options in the 
composite settings. These options are accessible directly from the corresponding fire resistance group in the 
composite menu. 

You define the intended fire resistance in minutes. In the case of failing fire checks, it is possible to define 
fire protection per beam. 

At the moment, only protection in the form of boards is supported. The protection is defined in terms of 
thickness, thermal conductivity, specific heat, and density. 
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  Chapter 5: Advanced analysis  
 
 

Aside from linear elastic analysis, certain advanced analysis types are supported in SCIA Engineer for 
structures with composite floors: second-order analysis with initial geometrical imperfections and/or 
tension-only elements, eigenvalue stability analysis, modal and spectral analysis. 

Linear analysis is automatically staged when composite floors are present in the model. This is not the case 
with more advanced analysis types. You should be aware that the construction stage in which the (e.g., 
second-order) analysis will be performed is automatically chosen per combination (based on the load cases 
that are contained in it) and that you can usually overwrite the stage manually. 

Metal deck roofs are often present in composite structures. In SCIA Engineer, these can be easily modelled 
by the Metal deck item (Input panel > workstation Structure > category 2D members). Metal decks are by 
default set to Flexible Diaphragm as Element behaviour. This allows for a simplified load transfer from the 
slab to the underlying beams based on tributary areas. 
In the context of nonlinear and stability analysis, flexible diaphragms become problematic due to their 
artificially reduced shear stiffness and it can lead to singularities. The Standard FEM setting usually works 
well in the case of second-order analysis with initial imperfections and tension only elements. 
If you are not interested in the behaviour of the sheet itself, it is a good idea to switch the element behaviour 
to Rigid Diaphragm. This is extremely beneficial in the case of stability analysis, because it eliminates any 
eigenmodes that represent deformation in the sheeting only. 

 

Nonlinear analysis 

Nonlinear analysis can be used for different purposes. We will make use of two types of nonlinearity: 

• tension-only behaviour for the lateral bracing; 

• second-order deformation with initial geometrical imperfections for the whole model. 

We can assign the Nonlinearity 1D of type ‘Only tension’ via Input panel > workstation Structure > Boundary 
conditions. 

 

This nonlinearity has an influence on the lateral stiffness of the structure, on the forces in the columns, but 
also on composite beams, in the case where K-bracing is framing into them. It assumes that the slender 
bracing elements will work only in tension and will buckle under compressive forces. 

The assigned nonlinearity is visualised on the beams. The symbols can be (de)activated via View settings for 
all entities > > Structure > Member parameters > Member nonlinearities. 
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We can now create a few nonlinear combinations and assign initial imperfections directly in the Nonlinear 
combinations dialog. We can see also there is an option to overwrite the stage of construction per nonlinear 
combination. You can take over the linear combinations via the button ‘New from combination’. 

 

To activate second-order effects, we need to activate the Geometrical nonlinearity functionality in the 
Project settings dialog. 

 

Then we can go to the Solver settings (accessible via the Calculation dialog or main menu > Tools > 
Calculation & mesh > Solver settings) Under Advanced solver settings > Nonlinearity we will select 3rd order 
and use the Newton-Raphson method of calculation to solve the nonlinear combinations we defined. This is 
because the Picard method does not handle the flexibility of the metal deck 2D member (if that one is 
switched to Standard FEM Element behaviour). 

 

After the nonlinear analysis you can evaluate the nonlinear results and you will notice that the internal forces 
will be different from the linear results since the compression forces will not be carried anymore by the 
bracings. Now you can perform the checks as we have seen before according to the nonlinear results. 
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Stability analysis 

The choice of construction stage for stability analysis is always automatic. The software selects the stage for 
calculation based on the load cases present in the calculation. In the case where only construction stage 
load cases are present in the stability combination, the analysis is performed in construction stage: assuming 
no stiffness or self-weight in the concrete slab. In the case there is at least one final stage load case, the 
analysis is run in final stage. For the choice between final stage long-term or short-term stiffness, the same 
logic is applied: if there are no load cases in the long-term stage, short term stiffness is used; if there is at 
least one, the long-term stiffness reduction is used for the concrete slab. 

We can create stability combinations with identical content to the ones we defined for the nonlinear analysis. 

After the stability analysis, you can evaluate the obtained results, conclude which eigenmodes are local, 
which ones are global, and make your conclusions based on this. 
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  Annex A: SCI 405  
 
 

Often, it is beneficial not to transfer the full resistance of the steel or concrete components of the composite 
cross-section via forces in the shear connectors: less is enough in order to provide sufficient bending 
moment resistance. It is the reason why partial composite action is so interesting in composite beam design. 
Eurocode 4 provides rules for the determination of minimal composite action. 

The SCI publication “P405 Minimal degree of shear connection rules for UK construction to Eurocode 4” 
often lets us achieve more economical design in the cases where requirements for minimal composite action 
govern the design. This NCCI summarises the findings of more recent experimental research into updated 
formulas for minimal composite action, involving more design parameters aside from the beam span and 
material yield strength (such as the orientation of sheeting and bending utilisation). 

The following graphs compare the rules of EN 1994-1-1 with SCI P405: it can be seen that EuroCode 4 can 
be too stringent, especially where the beams are not fully utilised in bending (which is often the case due to, 
e.g., SLS considerations). 

 

Whether SCI P405 is applied or not is controlled by an option in the composite settings for the whole model 
or via composite beam data per beam. You can influence the choice of curve/rule to be applied (also per 
beam), but only within the limitations given by SCI P405. Additional detailing rules are applied as well, as 
prescribed in the publication. 
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  Annex B: Checks at the reduced section (web openings)  
 

 

Checks at the reduced section 
 

Four additional ULS failure models will be checked at the location of each web opening: 

• global bending; 

• vertical shear; 

• Vierendeel bending; 

• shear buckling. 

Global bending 

Bending moments acting at the location of openings need to be taken by the reduced section. The derivation 
of the bending moment resistance is analogical to the one for an unreduced cross-section: 

 

• Section classification is performed: this concerns the outstands formed by the remainder of web in the 

top and bottom Tee sections. If the outstands do not fall under class 1 or 2, the length used in the 

calculations is reduced so that the Tee’s satisfy the class 2 limit. Horizontal stiffeners will also be taken 

into account in the classification. 

• SCIA Engineer will find the neutral axis location from the equilibrium of forces in the steel Tees and 

the concrete slab. Two cases are possible: neutral axis in the slab or in the top Tee. 

• The bending resistance will be calculated as a resultant of the forces acting on the Tee sections and 

the concrete slab. 

• If large shear forces are present at the location of openings (≥ 0,5 * Rd), the bending resistance will be 
reduced according to EN 1994-1-1. 

It should be noted that the bending resistance will not be significantly reduced due to the presence of web 
openings, as it is the flanges that take up the significant part of bending moments. It is estimated that the 
bending resistance will be reduced by a factor of: 

• in the case of unstiffened openings: 

1 − 0.35 ho 
h 

(where ho and h are the heights of the web openings and the web respectively) 

• in the case of stiffened openings: 

1 − 0.2 ho 
h 

 
 

Vertical shear will be taken up by the shear area of the two Tee sections, and an additional contribution 
from the concrete slab. There is an option in the composite settings that controls whether that extra 
contribution from the slab is to be taken into account. If yes, the formula used to calculate it is similar to a 
punching shear resistance of a concrete slab (as given in SCI P355 and EN 1992-1-1). 
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The name Vierendeel bending comes from an analogy to Vierendeel beams, where the diagonal elements 
normally present in trusses have been removed, leaving the chords and vertical elements. Shear between 
the top and bottom chord of a Vierendeel beam is transferred via large bending moments at the junction 
between the chords and verticals. An analogical failure mode is observed in beams with large web openings: 
the top and bottom Tees are subjected to additional bending due to the removal of the main element that 
carries shear – the bulk of the web. 

 

 

  

The top and bottom Tees are thus subjected to normal forces, shear, and bending moments; therefore, the 
interaction of these forces needs to be taken into account. 

The concrete slab also takes part of the Vierendeel bending moments. This is why larger web openings can 
often be provided in composite beams in comparison to steel beams acting alone. However, this slab 
contribution depends on the number of shear connectors that fit in the length of the opening. Therefore, the 
contribution of the slab to the Vierendeel bending resistance at short openings is minor. 

Adding horizontal stiffeners is extremely beneficial in the case of Vierendeel bending failures. 

Shear buckling 

In the case of widely-spaced or isolated openings, shear buckling can be taken up by strut and tie action in 
the steel web. As long as the openings in the web are at sufficient distance from each other, the shear 
buckling resistance may be obtained from the EC3 formula for beams with solid webs (see EN 1993-1-5, 
§5.2), if a reduction factor is applied to take the opening into account. The reduction factor given by SCI 

P355 is equal to 0.9 (1 — ƒ
hoSo), where ho  and lo  are the height and length of the opening and hw  is the clear 
hw 

height of the web. 

For this approach to be applied in the case of multiple openings along a beam, SCI P355 specifies that the 
clear distance between the openings (i.e. the web post width) should be greater than the (average) length of 
neighbouring openings. If this is not fulfilled, the publication specifies another method for the verification of 
vertical shear resistance in the case of closely spaced openings. In SCIA Engineer, this check is handled on 
the level of web-post verifications, see chapter Error! Reference source not found.. 
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The figure below explains the principle of strut and tie action in a beam with and without web openings when 
loaded with gravity loads. 

 

 

Checks at the web posts 
 

Four additional ULS failure models will be checked at the location of each web-post: 

• horizontal shear; 

• web-post bending; 

• web-post buckling; 

• vertical shear. 

Horizontal shear and web-post bending 

From the equilibrium of forces around a web post, it follows that the build-up of tension forces between the 
bottom Tee sections of neighbouring openings is balanced by a horizontal force at mid-height of the web- 
post. SCI P355 gives a formula to calculate Vwp,Ed. A sufficient amount of material, i.e. web post width, is 
required at mid-height of the web-post in order to take up this horizontal shear force. 

Web-post bending is only present if the opening(s) is eccentric to the beam axis. SCI P355 describes how 

Mwp,Ed should be derived if eo ≠ 0. 

Both failure modes can be remedied by increasing the distance between neighbouring openings, or by 
decreasing the eccentricity in the case of web-post bending failures. 
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Web-post buckling 

Slender web-posts can buckle under compression forces that act predominantly in a vertical direction and 
are a result of the vertical shear at the location of openings. For widely spaced openings, a slenderness 
check determines whether the web-post buckling check should be performed: 

• if  
ℎo/ 

w 

• if  
ℎo/ 

w 

> 25, the check is performed for circular openings, 

> 20, the check is performed for rectangular openings. 

The web-post buckling check differs depending on the spacing between openings. 

For closely-spaced openings, the compression force is resisted by the full width of the web post; for widely- 
spaced openings, the web-post buckling check is independent of the web-post width and the compression 
force is resisted by an effective width of web adjacent to the opening equal to 0.5ho. The transition from 
widely-spaced to closely-spaced openings is assumed at web-post width equal to the average length of 
adjacent openings. 

 

SCI P355 gives formulas for the determination of Nwp,Ed for both closely and widely-spaced openings. A 
special case here are eccentric openings, where the vertical compression force resisted by the web-post 
interacts with the bending moment Mwp,Ed at mid-height of the web-post. 

In SCIA Engineer, the check for web-post buckling is also performed in the case of single/isolated openings: 
the approach for widely-spaced openings is applied on the effective width of web adjacent to the opening. 

 

The check itself fully follows the EN 1993-1-1 methodology for columns buckling in compression. SCI P355 
gives the buckling lengths (or slenderness) of the equivalent compressed strut based on the openings 
shape, dimensions and spacing and specifies which buckling curves should be used. 

In the case of web-post buckling failures, it is beneficial to switch to a steel beam with a thicker web or adapt 
the eccentricity or spacing of openings. 

t 

t 
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Vertical shear 

The additional check for vertical shear is only relevant for closely-spaced openings (web-post width smaller 
than the opening length). 

In order to determine the maximal vertical shear resistance that can be achieved at a web-post, SCI P355 

derives a number of formulas for VRd by assuming different failure outcomes: 

• web-post buckling happening before web-post bending failure or vice versa, 

• failure happening after developing full shear connection with the concrete slab or not. 

As a result of these derivations, four formulas for VRd are provided for both circular and rectangular openings. 
The minimal VRd value from the four gives the actual shear resistance of the web-post. 
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